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RESUMO

Localizada no sudeste brasileiro, no Estado de Minas Gerais, Belo Horizonte possui
caracteristicas geograficas propicias aos efeitos negativos da chuva. Sua ocupacdo ao longo
do Ribeirdo Arrudas em um contexto de vales encaixados e colinas dissecadas, implicando em
elevadas declividades, sobretudo na porc¢do sul do municipio, aumentou as probabilidades de
ocorréncia de processos naturais perigosos (hidroldgicos e geoldgicos). Dentre eles, as
enxurradas sao escoamentos superficiais concentrados e com alta energia de transporte, que
afetam os moradores da cidade causando danos ou perdas dos bens materiais, ilhando casas e
comeércios, deteriorando as infraestruturas urbanas, arrastando carros nas ruas, provocando
atrasos por engarrafamentos no transito, entre outros. Diante da vulnerabilidade da populacéo,
esta pesquisa objetiva elaborar uma metodologia para 0 mapeamento do risco de enxurradas.
O método usado foi a analise multicritério que permitiu a elabora¢do de um mapa sintese da
susceptibilidade a formacdo de enxurradas em Belo Horizonte, utilizando a versdo 10 do
software ArcGIS. As varidveis selecionadas foram a declividade e a curvatura mapeadas a
partir das curvas de nivel com espacamento de cinco metros, e também os substratos
litolégicos das areas verdes urbanas. O mapa sintese permitiu a realizacdo de uma Carta de
Enxurradas de Belo Horizonte, que apresenta os trechos de ruas com maior susceptibilidade,
possiveis de serem mapeados na escala do Municipio (1:125.000), das suas regides
administrativas 1:40.000, a 1:65.000) e dos seus bairros (1:7.500 a 1:10.000).

Palavras-chaves: Susceptibilidade a formacdo de enxurradas, Manchas de Inundagdes, Risco

e Mapeamento.



RESUME

Situé au sud-est du Brésil dans I'état du Minas Gerais, la géographie de Belo Horizonte est
propice aux consequences des pluies torrentielles. Dans la portion sud de la municipalité ou
I’occupation urbaine s’étend jusqu’aux marges de la Riviére Arrudas et les collines
accentuées impliquent des déclivités tres élevées, les probabilités de se produire des processus
naturels (hydrologiques et géologiques) sont a la hausse. Parmi eux, les flux d’eau sont des
écoulements superficiels concentrés et pourvue d’un haut débit. Dans les villes, les habitantes
sont affectés de plusieurs fagons, provoquant entre autres des dommages ou pertes de biens
matériels, 1’inondation des commerces et des domiciles, la détérioration des infrastructures
urbaines et du retard causé par le trafic. Compte tenu de la vulnérabilité de la population,
cette recherche vise a décrire une méthodologie qui permet d’élaborer une carte du risque des
flux d’eau en milieu urbain. L’analyse multicritére a été la méthode utilisée a 1’aide du
logiciel ArcGIS 10, permettant 1’¢laboration d’une carte synthése du phénomene a 1’étude.
Les variables sélectionnées sont la déclivité et la courbure des pentes, cartographiées selon les
courbes de niveau espacées de cing metres, en plus des substrats lithologiques des espaces
verts urbains. Ces variables ont permis la réalisation d’une Carte des Flux d’Eau de Belo
Horizonte, illustrant le niveau de risque selon les trongons de rues. Celle-ci peut étre
cartographiée a I’échelle de la municipalité (1:125 000), de ses régions administratives 1:40
000, le 1:65 000) et de ses quartiers (1:7 500 a 1:10 000).

Mots-clés : Susceptibilité a la formation de flux d’eau, Inondations, Risque et Cartographie.
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INTRODUCAO

No Brasil, de maneira geral, a producdo do espaco urbano, e até mesmo metropolitano,
alimentou o desequilibro natural (MONTE_MOR, 1994). Os efeitos do processo de
urbanizacdo, tais como a intensificacdo de demanda social, o déficit habitacional e a
especulacdo imobiliaria, ocasionaram uma enfraquecida do poder publico no controle e
ordenamento do uso do solo. Constata-se, assim, que a ocupacao das margens dos rios e das
encostas pela moradia de baixa renda tornou-se a Unica alternativa de producéo de espaco. Os
rios urbanos eram utilizados como deposito de lixo, porque ndo havia um servico universal de
coleta de residuos sélidos e esgotos, e por Ultimo, a falta de vontade politica pela preservacéao
ambiental das areas protegidas e das bacias hidrograficas contribuiu para a deterioracdo dos
recursos naturais e afetou diretamente a qualidade de vida de todos os habitantes das regides
mais urbanizadas. Por consequéncia, nota-se uma intensificacdo de desastres naturais,
principalmente aqueles relacionados aos processos hidrologicos (enchentes, inundaces,
alagamentos e enxurradas) e geoldgicos (escorregamentos e quedas de blocos) causados pela

chuva desde os anos 1960.

Dentre esses processos, as enxurradas afetam os moradores de toda parte da cidade, causando
danos ou perdas dos bens materiais, ilhando casas e comércios, deteriorando as infraestruturas
urbanas, arrastando carros nas ruas, provocando atrasos por engarrafamentos no transito, entre
outros. Em Belo Horizonte, as vitimas fatais pelas forcas da &gua da chuva tornam-se
frequentes. Ainda em abril deste ano, um homem faleceu depois de ser levado pelo cérrego do

Onca, na Regional Nordeste.
Diante da vulnerabilidade da populacdo belo-horizontina, 0 mapeamento das areas de risco
surge como um instrumento de dialogo com a cidade, na busca de acbes de prevencdo. A

Carta de Inundacdo de Belo Horizonte ndo contempla as areas afetadas por enxurradas, e essa

foi a forga impulsionadora deste trabalho.

Objetivos especificos

Esta monografia objetiva elaborar uma metodologia para 0 mapeamento do risco de
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enxurradas no Municipio de Belo Horizonte. Apresenta-se, a seguir, uma série de etapas

sucessivas como formulacdo de objetivos especificos:

1. Elaborar os mapas tematicos referentes as caracteristicas fisicas e antropicas de Belo
Horizonte, sendo elas: declividade, curvatura e substratos litologicos das areas verdes
urbanas;

2. Mapear a susceptibilidade a formacédo de enxurradas em Belo Horizonte;

3. Realizar a Carta de Enxurradas de Belo Horizonte com destaque nos trechos de ruas

com maior susceptibilidade.

Justificativas

Diversos mapeamentos de risco decorrente da chuva forte foram elaborados para 0 Municipio
de Belo Horizonte. O primeiro surgiu em 1994, com a criacdo da Companhia Urbanizadora de
Belo Horizonte (URBEL). Para a realizagdo do diagnostico de risco geoldgico-geotécnico nas
vilas e favelas, o 6rgdo da Prefeitura de Belo Horizonte (PBH) zoneou as areas em que a
instabilidade das encostas e a drenagem das margens de corregos eram consideradas criticas
nas imagens satélites em estudo. Em 2004, a atualizacdo desse diagndstico resultou na adocao
de critérios de priorizacdo para uma classificacdo das areas em quatro categorias

hierarquizadas, sendo elas: baixo risco, médio risco, alto risco e muito alto risco.

A partir de 2009, a PBH se preocupou também com a elaboracdo de uma Carta de Inundacéo
de Belo Horizonte. O procedimento do monitoramento hidroldgico-hidraulico empregado pela
Superintendéncia de Desenvolvimento da Capital (SUDECAP) é bastante diferente daquele
utilizado para avaliar o risco geoldgico-geotécnico. O tempo de concentracdo de cada bacia de
contribuicdo ao local de extravasamento foi avaliado a partir da base de dados
planialtimétricos, convertida para utilizacdo no software Autocad que resultou na localizacao
das principais manchas de inundacdo, mapeadas na escala do municipio (1:125.000), das nove
regionais (1:40.000 a 1:65.000) e de outros recortes territoriais (1:7.500 a 1:10.000).

Na sua pesquisa sobre as eficiéncias e deficiéncias da gestdo de risco hidrometeorolégico em
Belo Horizonte, Paolucci (2012) questiona o processo de producgéo de bases cartograficas com

a finalidade de delimitagdo de manchas de inundagdes. Segundo a autora (p. 79), “ele néo



11

apresenta uma visdo integrada dos processos hidroldgicos, que compreendem as inundacdes,
as enchentes, os alagamentos e as enxurradas. Essas ultimas passam ao nivel cotidiano e ndo

sdo captadas pela cartografia”.

A partir de tal questionamento, tornou-se premente a realizagdo de um estudo sobre o
geoprocessamento aplicado a criacdo de uma Carta de Enxurradas de Belo Horizonte, que
venha corroborar com 0s anseios e propostas de campo da Cartografia. Ademais, cabe
considerar que 0 mapeamento das enxurradas € um assunto pouco estudado e o resultado pode
trazer muitos efeitos positivos, tanto na redugdo dos riscos quanto na melhoria do
planejamento urbano em geral. Esta monografia se referiu no modelo de apresentacdo visual e
escalas escolhidas pela SUDECAP devido a facil leitura da sua Carta de Inundacao de Belo
Horizonte, tanto para os profissionais da area quanto para a populacdo do municipio em geral.
Além disso, baseou-se na metodologia da dissertacdo de mestrado de Reis (2011), ao mapear
a suscetibilidade a formacéo de enxurradas na sub-bacia do Corrego do Leitdo, pertencente a
bacia do Ribeirdo Arrudas, com o objetivo de analisar o escoamento superficial como

condicionante de inundacdo em Belo Horizonte.

Procedimentos metodoldgicos

Algebra de mapas em geoprocessamento no ambiente ArcGIS

A analise multicritério vem sendo amplamente utilizada diante da complexidade do fenémeno
das enxurradas e da necessidade de encontrar solucdes que possam auxiliar na tomada de
decisdo. Esse tipo de andlise se constitui num sistema de suporte a tomada de decisGes
baseado na combinacdo de varidveis (ou critérios) segundo diferentes métodos que geram
como resultados planos de informacdo (geocampos) em diferentes formatos. Dentre eles, a
média ponderada, fuzzy, bayesiano e inferéncia por redes neurais geram dados com
potencialidade expressa de forma numeérica, enquanto o método booleano gera dados com
potencialidade expressa especialmente em forma de poligonos, que representam classes -
favoravel ou ndo favoravel (MOREIRA et al., 2001).

Como Reis (2011), utilizou-se o método booleano da analise multicritério como procedimento

metodologico de cruzamento de variaveis, possivel de ser realizado por meio de um Sistema
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de Informagéo Geogréfica (SIG). Esses sdo sistemas automatizados para armazenar, analisar e
manipular dados geograficos. Sua estrutura em banco de dados possibilita uma atualizacdo
constante das caracteristicas fisicas e antropicas para melhores resultados nos levantamentos
das areas de risco e andlises desenvolvidas. H4 uma grande disponibilidade de software de
SIG, permitindo que estas ferramentas sejam utilizadas para 0 mapeamento de areas de risco
de enxurradas. Dentre eles, a presente pesquisa contemplou diversas ferramentas da versao
10.2 do ArcGiIS.

Selecdo das variaveis

Ainda conforme Reis (2011), as causas das enxurradas determinaram as classes de

susceptibilidade segundo as variaveis a seguir:

A) Declividade até 5%;

B) Declividade de 6% a 10 %;

C) Declividade de 11% a 30%;

D) Declividade de 31% a 47%;

E) Declividade acima de 48%;

F) Superficie de curvatura convexa;

G) Superficie de curvatura plana;

H) Superficie de curvatura céncava;

1) Area urbana;

J) Area verde caracterizada por depositos aluvial, canga e coluvio laterizado;

K) Area verde do complexo Belo Horizonte com embasamento gnéissico de idade
arqueana predominante;

L) Area verde da formagdo Cercadinho, composta de quartzitos alterados com filitos
preteados;

M) Area verde das formacdes Fecho do Funil e Barreiro, composta por filitos carbonatos;

N) Area verde da formacdo Gandarela, composta por filitos dolomiticos e dolomitos;

0) Area verde do grupo Sabara, composta por Xistos e filitos.

Para mapear as areas de ocorréncias dos critérios diagndsticos acima indicados, empregou-se

a seguinte equacao de algebra booleana:
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{(AorBorCorDorE)and (ForGorH)and (lorJorKorLorMorNorQO)} >
AREAS SUSCEPTIVEIS AS ENXURRADAS

Coleta de dados

Os dados necessérios para a realizagdo da presente monografia foram disponibilizados em
formato shapefile (arquivo de extensdo .shp) por diversos 6rgdos da Prefeitura de Belo
Horizonte (PBH), sendo eles: curvas de nivel, uso do solo, vilas e favelas, cursos d’agua,
manchas de inundacéo, limite do municipio, das regides administrativas e dos bairros, vias
publicas e quadras. Esses dados estdo disponiveis na projecdo UTM (Universal Transversa de
Mercator) e datum SADG69 (South American 1969).
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CAPITULO 1

ELABORACAO DE MAPAS TEMATICOS PARA EVENTUAL CRUZAMENTO

Este capitulo cumpre o primeiro objetivo desta pesquisa, que consiste no mapeamento de cada
uma das trés variaveis selecionadas para a eventual analise multicritério: declividade,

curvatura e substratos litoldgicos das areas verdes urbanas.

1.1 Declividade

A declividade influencia a velocidade do escoamento superficial de uma bacia. Trata-se da
relacdo entre a amplitude e o comprimento de rampa, medida em graus ou porcentagem
(GUIMARAES, 2008).

Para a elaboragdo do mapa de declividade de Belo Horizonte, foram utilizadas as curvas de
nivel de cinco metros (shapefile Curvas_Nivel) e do limite do Municipio de Belo Horizonte
(shapefile Limite_BH), disponibilizadas pela Empresa de Informatica e Informacdo do
Municipio de Belo Horizonte (PRODABEL) em 2010.

A ferramenta chamada 3D Analyst Tools > Create Tin From Feature do software ArcGIS,
que possui algoritmos de manipulacdo, possibilitou a criagdo de um Modelo Numérico de
Elevacdo — MDE, a partir de um shapefile (arquivo com extensdo .shp) de curvas de nivel. Em
seguida, 0 MDE possibilitou 0 mapeamento da declividade com resolucdo espacial de 30

metros, por meio da ferramenta 3D Analyst Tools > Surface Analysis > Slope.

Conforme a Figura 1, os vertentes com declividade entre 31 e 47% ocupam uma area consideravel
do municipio, interferindo diretamente na velocidade da agua da chuva que se acumulam nas ruas,
nos becos e nos corregos. As vertentes com declividades muito elevadas (> 48%) apresentam-se
com maior importancia na por¢do do extremo sudeste e no nordeste do municipio. Belo
Horizonte, como muitas outras metropoles, tem parte de seus locais de forte declividade ocupados
por vilas e favelas. Nessas regides, a formacdo de enxurradas é certamente mais frequente devido

as consequéncias da alta taxa de impermeabilizacéo do solo.
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A forte declividade em Belo Horizonte se explica devido a fatores geoldgicos e geomorfologicos
que condicionam a esculturacao das formas de relevo, caracterizado por um total de 852 metros de
desnivelamento. Na porcéo sul, a Serra do Curral possui 0s pontos mais elevados, que atingem até
1.395 metros acima do nivel do mar. Na por¢do norte, 0os pontos mais baixos do terreno chegam a
543 metros, proximo aos leitos fluviais do Ribeirdo Isidoro e dos Corregos Calazans e Lagoa
Grande.
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1.2 Curvatura

A curvatura, também chamada de fei¢cbes geomorfoldgicas da superficie terrestre ou formas
do relevo, influencia na dispersdo da agua da chuva em uma bacia hidrogréfica. Trata-se da
variacdo da inclinacdo da tangente sobre dois pontos de um determinado arco (STABILE &
VEIRA, 2008). As areas mais baixas e planas, de baixo risco, sdo mais suscetiveis ao
acumulo de &gua. Essas areas ndo caracterizam o escoamento superficial em alto transporte,

diferentes daquelas convexas e concavas.

Para a realizacdo do mapa de curvatura vertical e horizontal com resolucdo espacial de 30
metros, selecionou-se a imagem raster (arquivo de extensdo .tif) de declividade na ferramenta
3D Analysis Tools > Raster Surface > Curvatura do software ArcGIS. A classificacdo é
aquela empregada por Reis (2011), segundo a qual a curvatura foi representada na forma

concava (> -0,08°/m), plana (-0,08°/m — 0,08°/m) e convexa (> 0,08°/m).

Conforme a Figura 2, as curvaturas concavas e convexas em Belo Horizonte coincidem com
as areas de declividade acima de 10%. Mesmo sem a andlise multicritério proposta na
presente pesquisa, pode ser previsto que vertentes concavas e de alta declividade seréo
coincidentes com as maiores susceptibilidades a formacdo de enxurradas. Pode-se deduzir
também que a direcdo preferencial do escoamento superficial sera condicionada de forma

paralela a elas.
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1.3 Substratos litologicos das &reas verdes urbanas

Para a elaboracdo do mapa dos substratos litoldgicos das areas verdes urbanas, consideraram-
se as areas verdes (parques, pracas, passeios verdes, canteiros centrais, loteamento
desocupados, entre outros), as areas urbanas e a Lagoa da Pampulha. As areas verdes foram
identificadas a partir das unidades de conservacdo (shapefile Vegetado UC), da Serra do
Cural (shapefile Vegetado Serra_Tombada), dos parques municipais (shapefile
Vegetado_Parques_ Municipais) e das areas do Programa BH Verde com mais de 40% de
permeabilidade (shapefile Vegetado BH_Verde 40 100). Em complemento, outras areas
verdes significantes foram localizadas a partir das bandas 3, 4 e 5 de uma imagem
TM/Landsat 5, através do método da Maxima Verossimilhanca no Programa Spring, no
ambito da monografia de Guimarées (2010). Todos esses dados foram disponibilizados pela
Geréncia de Sistemas de Informacdes Ambientais (GESIA) da Secretaria Municipal de Meio
Ambiente (SMMA) em 2011.

Os poligonos de areas verdes foram correlacionados com sua respectiva geologia (shapefile
Geologia). Conforme Parizzi (2004), o Complexo BH e Depdsitos Quaternarios abrangem o
predominio do embasamento gnaissico de idade arqueana (Complexo Belo Horizonte), além
de deposito aluvial, canga e coluvio laterizado. Na porcédo sul até a porcao central encontram-
se uma sucessdo de rochas paleoproterozdicas metassedimentares (subordinadamente
metavulcanicas), integrantes dos grupos Sabara (xistos e filitos), Piracicaba e Itabira. O grupo
Piracicaba é representado no municipio pelas Formacgdes Cercadinho (quartzitos alterados
com filitos preteados), Fecho do Funil (filitos) e Barreiro (filitos carbonatos), enquanto a

formacéo o Grupo Itabira abrange a formacdo Gandarela (filitos dolomiticos e dolomitos).

Para a presente pesquisa, a Geologia foi recortada no limite do municipio, dissolvido e
dividido em quatro agrupamentos de unidades geoldgicas, determinados segundo os valores
adotados por Reis (2011) na reclassificacdo dos substratos litologicos das areas verdes
urbanas para a analise multicritério. Apds recorte do shapefile Vegetado no limite territorial
de cada agrupamento de unidades geoldgicas, uniram-se aos Lagos e Urbanizado na criagdo
do shapefile Uso_Solo. Em seguida, foi necesséria a criagdo de um novo campo na tabela de

atributos para codificar as diferentes areas:
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- Lago ou Leito Natural (1);

- Area Verde do Complexo BH ou Depo6sito Quaternario (2);

- Area Verde da Formagcéo Cercadinho, Fecho do Funil ou Barreiro (3);
- Area Verde da Formacdo Gandarela (4);

- Area Verde do Grupo Sabara (5);

- Area Urbana (6).

Por ultimo, essas diferentes areas (ou poligonos) foram transformadas em imagem raster com
resolucédo espacial de 30 metros, por meio da ferramenta Convertion Tools > To Raster >
Feature to Raster. Conforme a Figura 3, as areas urbanas correspondem a aproximadamente
75% da area de todo o municipio. Ndo ha divida que a diminuicdo das areas verdes, com a
impermeabilizacdo do solo, a retificagdo de cursos d’agua ¢ o adensamento das edificagdes para
atender um montante populacional que chegou a 2.375.444 habitantes no Gltimo censo
demogréafico de 2010, aumentam susceptibilidade a formacao de enxurradas em Belo Horizonte.
Ressalta-se que a impermeabilizacdo do solo anula as caracteristicas de permeabilidade da
geologia da area e intensifica o processo de escoamento superficial, principalmente nas
vertentes concavas de maiores declividades. Cabe considerar, no entanto, que nem toda
geologia apresenta alta permeabilidade do solo. E o caso do Grupo Sabar4, que representa um

pouco menos de 20% das areas verde do municipio.



Figura 3 - Mapa dos substratos litologicos das areas verdes de Belo Horizonte
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CAPITULO 2

MAPEAMENTO DA SUSCEPTIBILIDADE A FORMACAO DE ENXURRADAS

Este capitulo cumpre o segundo objetivo da pesquisa, que consiste na elabora¢do de um mapa
sintese da susceptibilidade a formac&o de enxurradas no Municipio de Belo Horizonte, usando
0 cruzamento das imagens raster de declividade, curvatura e substratos litoldgicos das areas

verdes urbanas. Para tanto, as variaveis analisadas devem ser reclassificadas.

2.1 Reclassificagdo das variaveis analisadas

A reclassificacdo das variaveis é fundamental para a validade do cruzamento das variaveis,
tornando-se possivel no software ArcGIS por meio da ferramenta Spatial Analyst Tools >
Reclass > Reclassify. No caso da declividade, da curvatura e dos substratos litologicos das
areas verdes urbanas, esses novos valores de 0 a 10 de acordo com a importancia para a
formacéo de enxurradas foram baseadas no estudo de Reis (2011).

A autora (p. 39) adotou os valores de declividade mencionados na Tabela 1,

de acordo com a descricdo de Guimardes (2008), que afirma que um solo de baixa
declividade apresenta escoamento com baixa velocidade e, consequentemente, a
capacidade de transporte fica limitada a vazdo de escoamento. Além disso, as
enxurradas, como relatado na revisdo bibliografica, sdo caracteristicas de chuvas
intensas e concentradas e de escoamento rapido e intenso.

Tabela 1 - Valores adotados para reclassificacao da declividade

Declividade Valores adotados
Em graus Percentual
0-3 0-5 2
4-6 610 4
7-17 11-30 6
18 - 25 3147 8
> 26 > 48 10

Fonte: Reis, 2011.
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A mesma autora (p. 39) adotou os valores de curvatura na Tabela 2,

conforme Stabile & Veira (2008), que consideraram valores negativos como
cbncava, positivo como convexo e valores proximos de zero como curvatura
retilinea. Estas valoragGes também foram utilizadas por Moreira et al. (1998), que
descrevem que quando uma vertente apresenta seus angulos de declividade
constante, tém uma curvatura retilinea, quando os angulos aumentam continuamente
para baixo, ttm uma curvatura positiva (convexa) e, finalmente, quando ocorre dos
angulos decrescerem para baixo tém uma curvatura negativa (cdncava).

Tabela 2 - Valores adotados para reclassificagdo da curvatura

Superficie de curvatura (°/m) Valores adotados
Convexo <-0,08 1
Plano -0,08 - 0,08 6
Concavo >0,08 10

Fonte: Reis, 2011.

Conforme a Tabela 3, que apresenta a reclassificacdo dos valores dos substratos litoldgicos
das areas verdes urbanas, a agua foi representada pelo 0 devido a impossibilidade de
ocorréncia de enxurradas em lagos ou leitos naturais. Ao oposto, o valor mais alto (10) foi
atribuido as areas urbanas que representam total impermeabilizacdo devido a presenca de vias

pavimentadas e edificios.

Entretanto, Reis (2011, p. 40) determinou valores para cada tipo litoldgico de acordo com sua
caracteristica de permeabilidade descrita por Silva et al. (1995). O Complexo Belo Horizonte,
o0s depositos quaternarios e as Formacgdes Cercadinho, Fecho do Funil, Barreiro e Gandarela
apresentam areas de melhor permeabilidade em Belo Horizonte. Para tanto, esses tipos de
lithologia receberam uma reclassificacdo dos seus valores entre 3 e 5. Ja que o Grupo Sabara
constituido de xistos e filitos representa uma area mais impermeavel quando comparada com

as demais geologias dentro do municipio, o valor 7 Ihe foi atribuido.
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Tabela 3 - Valores adotados para reclassificagdo dos substratos litoldgicos das areas

verdes urbanas

Caracteristicas do solo Codificagdo | Valores

adotados
Lagos ou leitos naturais 1 0
Complexo BH e Deposito Quaternarios 2 3
Geo!ogla Formacdes Cercadinho, Fecho do Funil e Barreiro 3 4

das areas

verdes Formacdo Gandarela 4 5
Grupo Sabara 5 7
Areas urbanas 6 10

Fonte: Reis, 2011.

2.3 Modelo prospectivo usando o método booleano

A élgebra de mapas proposta por Reis (2011) é a equacdo de soma, obtendo como resultado

um mapa sintese dos trés mapas intermediarios. Utilizou-se a ferramenta Spatial Analyst

Tools > Overley > Weighted Overley do software ArcGIS. A estratégia proposta pondera

igualmente e redimensiona as trés imagens raster segundo uma escala de 1 a 10 (10 sendo o

valor mais pertinente). No entanto, cabe considerar outros métodos de analise multicritério

que possibilita a ponderacdo desigual das variaveis.

Conforme a Tabela 4, o mapa resultante do processo de algebra foi reclassificado com quatro

classes de andlise, segundo o método manual, de modo a observar uma predominancia dos

locais de baixo e médio risco em relacdo aqueles de muito alto risco. A analise dos critérios

de susceptibilidade as enxurradas em Belo Horizonte resultou no modelo prospectivo

apresentado na Figura 4.

Tabela 4 - Classes de susceptibilidade a formacédo de enxurradas

Valores reclassificados Classes de susceptibilidade
0-6 Baixo risco
6-7 Médio risco
7-8 Alto risco
8-10 Muito alto risco

Fonte: PAOLUCCI, 2014.
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Figura 4 - Mapa sintese da susceptibilidade a formacao de enxurradas em Belo Horizonte
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CAPITULO 3

MAPEAMENTO DOS TRECHOS SUSCEPTIVEIS AS ENXURRADAS

Este capitulo cumpre o terceiro objetivo da pesquisa, que consiste na elaboracdo da Carta de
Enxurradas de Belo Horizonte, mapeada na escala do municipio (1:125.000). Para maiores
esclarecimentos e na intengdo de apontar as possibilidades que oferecem a metodologia
proposta nesta pesquisa, essa carta foi reproduzida nas escalas das regides administrativas
(1:40.000 a 1:65.000) e de um dos bairros populares (1:7.500 a 1:10.000). Para tanto, foi

necessario encontrar a melhor forma de representar os locais de maior risco de enxurradas.

3.1 Atribuicéo das informacdes de superficie

As inundacdes, enchentes e alagamentos sdo responsaveis pela acumulacdo da chuva nos
cursos d’agua ou em outros locais da cidade, razdo pela qual eles sdo geralmente ilustrados
por manchas de inundagdo. Estas ndo sdo representativas das enxurradas, definidas como
escoamentos superficiais concentrados e com alta energia de transporte (TOMINAGA;
SANTORO; AMARAL, 2009). Na cidade, estas Gltimas podem ou ndo ser associadas as areas
de dominio dos processos fluviais, mas, sobretudo, sdo direcionadas pelas ruas. Sendo assim,
propde-se 0 mapeamento da susceptibilidade a formacéo de enxurradas por trecho de rua.

Para atribuir entidades com informacGes espaciais proveniente de uma superficie, a versdo 10
do software ArcGIS possui a ferramenta 3D Analyst Tools> Funcional Surface > Add Surface
Information. Nela, foram selecionadas as Vias Publicas como entidades e o modelo
prospectivo de enxurradas como superficie 3D. Resultou-se na inser¢do de novos campos na
tabela de atributos das Vias Publicas. Dentre eles, Z MEAN que representa geralmente a
altitude média no cumprimento da linha coincidiu com a média entre os valores
reclassificados mais baixo e mais alto no cumprimento da linha. A Figura 5 comprova a
validade da ferramenta de atribuicdo das informacgdes de superficie para ilustrar o risco de

enxurradas por trecho de rua.
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Figura 5 - Comparacéo da classificagdo de risco de enxurradas entre os
pixels do modelo prospectivo e os trechos de rua
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3.2 Elaboracéo de mapas

A interpretacdo de que “o escoamento superficial nas areas urbanas ¢ um forte condicionante
das inundagdes, enchentes e alagamentos” (Reis, 2011, p. 75) torna premente a retomada da
maioria dos dados da Carta de inundacgdes de Belo Horizonte. Um deles sdo os cursos d’agua
(shapefile Cursos_d’agua) que caracterizam uma rede complexa de ribeirGes e corregos. O
arquivo disponivel na SUDECAP possui uma tabela de atributos que indica sim (S) ou nédo
(N) nos campos LEITONAT, CANALAB e CANALFECH. Nele, foi criado um novo campo
para adotar a classificacio do Orgéo em 2009:

- Curso d’agua em Leito Natural se estd em leito natural e considerado como principal;

- Curso d’agua Canalizado Aberto se a canalizagdo deste for a céu aberto;

- Curso d’agua Canalizado Fechado se a canalizagdo deste for coberta;

- Curso d’agua Canalizado em Se¢do Tubular se este ndo possui nenhuma especificacao;

- Curso d’4gua Nao Cadastrado se estd em leito natural sem ser considerado como

principal.

As manchas de inundacdo (shapefile Manchas_Inundacdo) sdo o resultado de estudos de
modelagem hidroldgica e hidraulica realizados pela SUDECAP em 2009, permitindo maior
conhecimento das bacias hidrogréficas da cidade e possibilitando a identificacdo de trechos
criticos ou sujeitos as ocorréncias de inundagdes. Essas manchas foram disponibilizadas em

agrupamento de shapefiles de diferentes geometrias, arquivados por regional. A partir deles,
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precisaram-se unir os shapefiles de linhas de todas as regionais do municipio, fazer a
conversdo geométrica para obter poligonos, gerar uma zona tampéo de um metro e suaviza-

los com uma tolerancia maxima de cinco.

Por altimo, foi preciso ilustrar as areas verdes (shapefile Uso_Solo_2014) consideradas na
presente pesquisa, além das vias (shapefile Vias_Publicas), as quadras (shapefile Quadras), o
limite das regides administrativas (shapefile Limite_Regional) e os bairros populares, que
pertencem a base cartografica da PRODABEL. As Regides Administrativas foram atualizadas
de acordo com a nova delimitacdo dada pela Lei n° 10.231 de 2011. S&o um total de nove
regionais, sendo elas: Barreiro, Centro-Sul, Leste, Nordeste, Noroeste, Norte, Oeste,
Pampulha e Venda Nova. O limite dos 486 bairros, por sua vez, foi atualizado de acordo com
a delimitacdo dada pela Lei n° 9.691 de 2010 para o Censo Demogréafico do mesmo ano. Cabe

considerar que o Bairro Cruzeiro foi o Unico mapeado nesta pesquisa.

Os dados presentes na Carta de inundagdes de Belo Horizonte, conforme sua representacao
em diversas escalas nos Anexos A, B e C, favorecem a contextualizagdo das enxurradas no

Municipio.

Carta de Enxurradas na escala do municipio

Os dados ilustrados na Carta de Enxurradas de Belo Horizonte na escala do municipio sdo os
trechos de ruas classificados de baixo a muito alto risco, as quadras, as manchas de
inundagdo, os cursos d’agua, a Lagoa da Pampulha e os limites da divisa regional com a
atribuicdo do nome das respectivas regides administrativas. Contam-se 6,4% dos trechos de
rua com maior susceptibilidade as enxurradas, representando aproximadamente 230 km de
distancia. A regional com maior proporc¢do de trechos criticos é a Centro-Sul. Ao oposto, as

Regionais Norte, Pampulha e Venda Nova sdo aqueles menos susceptiveis as enxurradas.

Carta de Enxurradas na escala das regides administrativas

A Carta de enxurradas com recorte em cada uma das nove regides administrativas retomam os
dados anteriores, acrescentando a localizagdo das vilas e favelas. Ao observar 0s mapas no
Anexo B, percebe-se a correlagdo entre as vilas e favelas e as areas de muito alto risco de

enxurradas. Alem disso, ilustrou-se o nome dos bairros populares (apenas aqueles que
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aparecem sem ultrapassar o poligono) por meio da ferramenta Layers Properties... > Data
Frame > Clip to Shape. No caso da publicacdo de uma eventual base cartografica das
enxurradas de Belo Horizonte, organizada por mapas dos bairros na escala 1:7.500 ou
1:10.000 e exportada no formato de uma folha A4 (210mm x 297mm), sugere-se que alguns
bairros sejam ilustrados em mais de um mapa, enquanto outros poderiam ser reunidos em um

mesmo mapa.

Carta de Enxurradas na escala de um bairro

A Carta de enxurradas na escala local possuem os mesmos dados mencionados para a escala
das regides administrativas, ilustrando ainda o nome dos bairros populares e, desta vez,
acrescentando a tipologia e 0 nome das Vias Publicas. O emprego da carta de enxurradas por
segmento de logradouros certamente auxiliara na politica publica, limpeza urbana e
estruturacdo de coleta de &guas pluviais. Diferentemente das cartas dos demais recortes
territoriais, todos os trechos de rua sdo ilustrados de acordo com sua classe de susceptibilidade
as enxurradas. No Cruzeiro, escolhido como exemplo na presente pesquisa, muitos trechos de
rua sdo criticos a ocorréncia de enxurradas, sendo dois deles considerados de muito alto risco
(Rua Prata e Rua Jornalista Jair Silva). Seu valor é de respectivamente 8,1/10 e 8,2/10, devido

a sua localizac&o em &rea urbana com vertente altamente ingreme e convexa.
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CONSIDERACOES FINAIS

O principal objetivo desta monografia foi elaborar uma metodologia para 0 mapeamento do
risco de enxurradas no Municipio. Para tanto, fez-se necessario descrever o procedimento da
elaboracdo dos trés mapas bases para a realizacdo da analise multicritério, sendo eles:
declividade, curvatura e uso e ocupacédo de solo. Em seguida, foram apresentadas as etapas do
mapeamento da susceptibilidade a formacdo de enxurradas em quatro classes de risco e da
realizacdo de uma Carta de Enxurradas de Belo Horizonte, destacando os trechos de ruas com

maior susceptibilidade.

O uso de uma carta como essa certamente aumentard a capacidade operativa em termos de
tempos de intervencdo e de qualidade das decisdes. Os pesquisadores e técnicos passardo a
dispor de mais conhecimentos sobre a determinada &rea. Traz maior eficacia por permitir uma
profundidade de analise que normalmente ndo é possivel com as ferramentas atuais. Também
permite 0 desenho mais adequado de politicas pablicas, proporcionando maior eficiéncia da

gestdo de riscos decorrente da chuva, principalmente aqueles relacionados as enxurradas.

A Prefeitura de Belo Horizonte (PBH) pode, eventualmente, usar tal ferramenta para a
formacdo de novos Nucleos de Chuvas (NACs) e Nucleo de Defesa Civil (NUDECS), grupos
de voluntarios que vivem ou trabalham proximo as areas mais criticas a chuva forte. Esses
grupos também foram capacitados respectivamente pela equipe da Companhia Urbanizadora
de Belo Horizonte (URBEL) e do Programa DRENURBS, integrante a Superintendéncia de
Desenvolvimento da Capital (SUDECAP), para receber e repassar alerta da PBH aos outros

moradores, além de informa-los sobre locais de abrigo e rotas de fuga.

Outras utilidades a esta ferramenta sdo a escolha de localizacdo estratégica para a execucao de
pocos e trincheiras de infiltracdo, a preservacao de areas verdes, 0 aumento de pracas publicas
e parque municipais, assim como a instalacdo de mais placas para informar a populacdo das

areas mais criticas em caso de chuva forte.

Enfim, cabe considerar que o mapeamento dessas areas possibilita eventual produgdo de
mapas falados, que traduzem a realidade local a partir da experiéncia vivida, representando as

areas de enxurradas maiores do que aquelas identificadas pelas técnicas de geoprocessamento



31

e eliminando outras que ndo sdo &reas construidas (ocupacdo por moradias ou infraestrutudas
urbanas). Os mapas falados sdo produzidos a partir da localizacdo das ocorréncias de
acidentes (local e data), relacionando-os as caracteristicas do terreno (declividade, curvatura,
geologia e permeabilidade do solo) e presenca de pogos e trincheiras de infiltracdo de aguas

pluviais e escoamento superficial.
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